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All efforts have been made to ensure the accuracy of this Guide. However, should any 
errors be detected, Datacolor would greatly appreciate being informed of them. 
Changes are periodically made to the information and will be incorporated in new edi-
tions of the guide. 

Datacolor reserves the right to make improvements and/or changes in the product(s) 
and/or program(s) described in this guide at any time.

Copyright © 2005 Datacolor. All rights reserved. This guide may not be reproduced or 
copied, in whole or in part, without the written permission of Datacolor.

Trademarks
Throughout this manual, trademarks are used. Rather than place a trademark symbol at 
every occurrence of a trademark name, we state here that we are using the names in an 
editorial fashing with no intention of infringement the trademark.
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About this Guide

Who Should Use this Guide?
This is the Datacolor MONITOR User’s Guide. It is to be read by users of the Datacolor 
MONITOR system, who need to know how to begin using the programs. Once you are 
familiar with Datacolor MONITOR, this guide provides a reference to help you carry out 
specific tasks using the system. This guide assumes you are familiar with Microsoft 
Windows.

How to Use This Guide
This guide is divided into the following main chapters:

Preface Edition, copyright and trademarks, impor-
tant addresses.

Contents Table of contents.
1 About Information about this guide.
2 Installation Installation description for Datacolor MONI-

TOR.
3 Configuration and Administration Configuration and administration of 

Datacolor MONITOR.
4 Using Datacolor MONITOR This chapter provides you with the basic 

information you need to start and use the 
system. A step by step description shows 
you the specification of the basic data and 
the calculation and correction of recipes.

5 Maintenance and Error Handling Maintenance of the spectrophotometer, the 
database and error handling.

6 Windows and Dialog Boxes Description of the windows and dialog 
boxes with their parameters. In Chapter 2 
Installation, Chapter 3 Configuration and 
Administration and Chapter 4 Using Data-
color MONITOR, some dialog boxes are 
described in connection with their use. 

7 Index The index should help you to find the 
descriptions you need.
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Type Styles and Symbols
The following type styles and symbols have been used in this guide:

• References to other chapters and sections of this guide are shown in italics, e.g., 
Refer to General Table Functions.

• Screen texts (window titles, parameter names, etc.) are written between double 
quotes, e.g., 
“Explorer” window.

• If a user action is requested, menu functions or button names are highlighted in 
bold, e.g., 
Click Save.

• A note is used to draw your attention to additional useful information, e.g.:

• A caution symbol is used to draw your attention to potential hazards, e.g.:

Note:
Leave the spectrophotometer to warm up for a few minutes. Datacolor recommends 
that for the greatest accuracy you should wait thirty minutes before calibrating.

Caution
An alteration of these parameters can interrupt the communication between the 
PC and the spectrophotometer.
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Supported Operating Systems
Workstations
Windows XP Professional

Windows 2000 Professional

Windows NT 4.0, service pack 4 or higher

Windows 98   Not recommended!

Server
Windows XP Server

Windows NT Server, service pack 4 or higher

Windows 2003 Server

Installing Datacolor MONITOR

Action Result

1 Insert the Datacolor MONITOR com-
pact disc into the CD-ROM drive.

If the installation does not start auto-
matically, select Run on the Win-
dows start menu, type

<drive ID>:\setup
(<drive ID>: is the identification of 
the CD-ROM drive, e.g., D:.)
in the “Open” field of the “Run” dia-
log box, and click OK.

The installation program starts automat-
ically.

2 Follow the advice of the installation 
program.

Note
After installation, the software runs in the demonstration mode and must be validated. 
Refer to New Installations on page 2-4.
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Updating Datacolor MONITOR
For the installation of an upgrade, refer to the installation description of the update and 
to Installing Datacolor MONITOR on page 2-2.

Caution!
• The database is upgraded by the update program. But, it is strictly recom-

mended to back up the database before updating. Otherwise, for some ver-
sions of the program the database could be deleted and lost.

Note
• If an old DCIMatch, SmartSort, CentersideQC or Fibramix program is updated to 

one of the new Spectrum Textile software products, the old software is removed 
during the installation of the new Spectrum Textile products like Datacolor 
MATCH, Datacolor SORT.

• If the software security key is not accepted after updating the software runs in the 
demonstration mode and must be validated. Refer to Existing Installation on 
page 2-5.
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Datacolor Security System
A new Software/Hardware security system replaces the old software protection pro-
vided by the green parallel port security key.

New Installations
New purchases receive a sticker containing their serial number. This is typically found 
on the corner of the jewel case. 

The software can be installed normally. After installation and if the software is running 
for the first time, the following dialog box appears:

From the date of the first use, you have 30 days to validate the software. (Any attempt 
to change this system date will immediately end the demonstration period.)

1 During this period, press the Continue button to start the software in demonstra-
tion mode. It is possible that not all features will be available while in the demon-
stration mode. 

The users should validate their software as soon as possible, as it may take up to seven 
days to do so. 

2 Visit http://pmweb.datacolor.com, call the local sales office, the Lawrenceville or 
Dietlikon call centers or mail the necessary information to Datacolor 
(SoftwareLicense@Datacolor.com) using the validation instruction sheet pro-
vided with the software.
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Existing Installation
If you already have one of the following Datacolor software packages: 
Datacolor MONITOR, MatchExpress, or Datacolor Process, that run using a green soft-
ware security key and receive an upgrade due to an upgrade purchase or a software 
maintenance agreement that does not require re-licensing, your software will run as 
before. Continue to use the green software security key.

What Happens if the Software Security Key Stops Working?
If the software security key fails to work for any reason, the software will be converted to 
the fourteen days demonstration period. The user then has two options:

• First, check the software security key and make sure that it is still properly 
attached to the system. If not, reattach it and the software should run normally.

• If it is attached and still fails to respond, the software security key may have 
failed. Use one of the methods listed in the New Installations section to contact 
Datacolor for validating the software using the software security component.

What Happens if the User Changes Computers?
If the user needs to change computers, the software will need to be re-validated. Simply 
follow one of the procedures listed in the New Installations section to contact Datacolor 
with an explanation of why you need to re-validate your software. The validations will be 
tracked in the Datacolor network to detect any abnormalities and protect the value of 
your software purchase. 

Upgrading Your Purchase
Some software packages offer the ability to upgrade the user's purchase level. Using 
the software security model, it is now easier for users to upgrade their purchase if they 
want a higher level of software or a new feature module. Simply contact your sales rep-
resentative to make the purchase. You will be issued a new serial number and a new 
validation number for your computer. That enables you to run the new features.

Note
In this case, the website will not directly validating the user's software, but an email will 
be generated for a validation request.
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Removing Datacolor MONITOR

Action Result

1 On the Windows desktop, double-
click the My Computer icon.

The “My Computer” dialog box appears.

2 Double-click Control Panel The “Add/Remove Programs Proper-
ties” are opened.

3 Double-click Add/Remove Pro-
grams.

The “Add/Remove Programs Proper-
ties” are opened.

4 Select “Datacolor MONITOR”, click 
Add/Remove, and confirm the 
removing.

Datacolor MONITOR is removed.

5 If Sybase is not used again (,e.g., for 
Datacolor Process,) it can also be 
removed.
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User Administration

Specifying, Modifying and Deleting User’s Data

Changing the Password

Note
Only the user “DCI” can specify and modify user’s data.

Action Result

1 On the Tools menu, select User 
Manager - User Administration.

The “User Administration” dialog box 
appears.

2 In the “User’s List,” select a user, 
and click: 

Add to specify a new user;

Remove to delete of a user’s data.

Rename to rename a user;

Add: The “Add a New User” dialog box 
appears. Insert name and password, 
and click OK.

Remove: The user data is removed 
after confirmation.

Rename: The “Rename a User” dialog 
box appears. Specify the new name, 
and click OK.

3 If finished, click Close. The “User Administration” dialog box is 
closed.

Note
The user „DCI“ cannot be deleted and has all access rights. These rights cannot be 
modified. 

Action Result

1 On the Tools menu, select User 
Manager - Change Password.

The “Change Password” dialog box 
appears.

2 Insert the old and new password, 
and confirm the new one.

3 Click OK. The password is changed.
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Access Rights

Action Result

1 On the Tools menu, select User 
Manager - User Administration.

The “User Administration” dialog box 
appears.

2 Select the requested user and click 
Permissions.

The “User Permissions” dialog box 
appears.

3 Set the permissions and click OK. The “User Permissions” dialog box 
closes.

4 In the “User Administration” dialog 
box, click Close.

The “User Administration” dialog box 
closes.
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Available options

Note
The setting of a user right is valid for all attached rights at lower levels.

Level Lower 
Levels 
Included

Option

0 + Main

1 Delete and Rename

1 Copy Data

1 + File

2 + Basic Data

3 Product

3 Quality/Style

3 Dye Process

3 Customer

3 Color Type

3 Parameter Definition

3 Tolerance

3 Combined Process

3 Operation

3 Sample

3 Fiber

3 Fiber Group

3 Affinity

3 Substrate Delivery

3 + Browse Date

4 Illuminant List

4 Sample List

4 Color Type List

4 Tolerance List

4 ... (refer to menu „Basic Data“)

3 Display

3 Print

3 ASCII Output

2 + Recipe

3 History

3 Match

3 Match in Background

3 ... (refer to menu „Recipe“)

2 + Colorant Set

3 Colorant Set Calibration
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3 Colorant Set

3 Display

3 Print

2 + SmartMatch

3 All menu options of SmartMatch

2 + Batch Series

3 All menu options of SmartMatch

2 Send Mail

2 Scan Mail

2 + Production

3 Dye Lot

3 Production Recipe

3 Administration

1 + Tools

2 Tool Bar

2 Status Bar

2 + User Manager

3 Change Password

3 User Administration

2 ... (Refer to menu „Tools“)

2 + Options (exception: dialog tabs)

3 View

3 Dispenser

3 Stock Solution

3 Unit Selection

3 Print

2 Import

2 ... (Refer to menu „Tools“)

1 + Instrument

2 All menu options of Instrument

Level Lower 
Levels 
Included

Option
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Browser Customizing

You can select the table columns to be displayed as follows:

Action Result

1 On the context-sensitive menu, 
select User’s Browser Definition.

The “Browse Columns for Explorer” dia-
log box appears.

2 Select the data type (table). The related data tree is displayed.

3 Check the boxes, the table columns 
have to be displayed.

In the footer of the dialog box, the 
checked table column titles are dis-
played.

4 Click Save. The settings for the selected table are 
saved.

5 Repeat steps 3 and 4 to display 
other table columns.

Repeat steps 2 to 4 to alter the dis-
play of other tables.

6 Click Close to close the “Browse 
Columns for Explorer” dialog box.

Note
The Reset button deselects all table columns except the object name. It is used if the 
performance of displaying is not acceptable.
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You can alter the column titles of the tables as follows:

Using the mouse, you can change the sequence of the table columns by drag and 
drop.

You can alter the position of column titles by drag and drop:

Action Result

1 On the context-sensitive menu, 
select User’s Browser Definition.

The “Browse Columns for Explorer” dia-
log box appears.

2 Select the data type. The related data tree is displayed and 
the checked table column titles are dis-
played in the footer of the dialog box.

3 A double-click in a table column title 
opens the “Custom Name” dialog 
box.

Refer to the figure on the previous 
page.

4 Specify the custom name, and click 
OK.

The table column title is altered.

5 Repeat steps 3 and 4 to alter other 
table column titles.

6 Click Save.

7 Click Close to close the “Browse 
Columns for Explorer” dialog box.
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Browse Filters
It is possible to specify customized filters (queries) for selecting data from the database. 
Customized filters can be ordered from Datacolor. Please contact your Datacolor 
distributor for more information.

Using Browse Filters

Note
• The integrated tool for customizing filters needs advanced know-how of both the 

database and SQL.
• Filters are language dependant. They can only be specified and used with appli-

cations that have the same application language.

Action Result

1 On the context-sensitive menu of the 
requested list window, click Filter.

The “User Definable Filters” dialog box 
appears.

2 In the „Prepare Filter“ tab, select the 
filter, type the identification(s) of the 
objects in the fields, and click OK.

The selected objects are displayed in 
the list window.
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Disabling Browse Filters

Exporting and Sending Browse Filters
A filter definition can be exported to a file or be attached to an e-mail.

Action Result

1 On the context-sensitive menu of the 
requested list window, click Reset 
Filter.

Action Result

1 In the „Define Filter“ tab of the “User 
Definable Filters” dialog box,

• click Export to export the filter 
definition to a file.

• click Send Mail to mail the fil-
ter definition.

The „Save as“ dialog box appears. The 
file can be saved with the extension 
„.dmf“.

The e-mail form appears and the filter 
definition file is attached.
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Importing Browse Filters

Importing Browse Filters directly from the E-mail

Action Result

1 In the „Define Filter“ tab of the “User 
Definable Filters” dialog box, click 
Import.

The „Open“ dialog box appears. The file 
with the extension „.dmf“ can be 
opened and imported.

Action Result

1 On the File menu of the overview 
window, click Scan Mail.

All attached files with the extension 
„.dmf“ are searched und displayed in 
the „Loading Filters from Mail“ dialog 
box.

2 Select the requested files, and click 
Load.

The selected files are imported.
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Import and Export
Datacolor MONITOR supports the import/export of samples and colorant sets with dif-
ferent file formats:

• Sample Import/Export with Datamatch format (*.EXP, *.EXQ files)
• Sample Import/Export with Datacolor Envision or Datacolor Tools (*.QTX files)
• Sample Import/Export with Datacolor MONITOR (*.XML files)
• Colorant Set Import/Export with Datacolor MONITOR (*.XML files).
The XML files may become very big (a file with 120 samples is about 370KB). You can 
compress them drastically (24 KB) using WinZip.

Exporting Data
Export function for color samples.

Note
Internet Explorer Version 5.01 Sp2 or higher must be installed to run the Import/Export 
of XML files.

Action Result

1 On the Tools menu, select Export. The “Export” dialog box appears.

Refer to Export Dialog Box on page 6-
33.

2 Select the data type and the format. Attention: Datamatch, Datacolor 
Tools or Datacolor Envision cannot 
import XML files.

3 Specify path and file name of the 
export file or use the browse func-
tion, and click Export.
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Importing Data

Action Result

1 On the Tools menu, select Import. The “Import” dialog box appears.

2 Specify path and file name of the 
import file or use the browse func-
tion.

Refer to Import Dialog Box on page 6-
32.
Refer to Importing Colorant Sets on 
page 3-13 for importing colorant sets.

3 Click OK. If the corresponding options are set, all 
or the existing samples are prompted. 
You can Save, Save with Prefix, or 
Skip them.

Note
• Samples are not imported if either the name or the spectral data is the same as 

data that already exits in the database.
• The import function compares the spectral data when the sample name already 

exists. A new sample is only created if the spectral data is different. E.g., if sam-
ple „Blue 4711" is already in the database, the imported sample, which has the 
same name but different spectral data, is imported as „Blue 4711 - 001".

• Samples imported from EXP files are always stored in the database. If the sam-
ple name already exists, a new sample is created with an extension in the name, 
e.g. sample „Blue 4711" is saved as „Blue 4711-0“.
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Importing Colorant Sets

Note
• If you import a colorant set that already exists, the program updates the new 

data. Calibration data is always updated. Dyestuff prices are not imported.
• If the fiber of the colorant set does not exist in the database, a dialog opens 

where you can select an equivalent from your database.
 This is to avoid creating the same fibers in different languages (e.g. Co, Bw, 

etc).
• If there is no fiber in the database that matches the fiber of the colorant set, click 

No Match . A new fiber is then created.
• Click OK to start the import.
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Note
• The dye class is treated in the same way as the fiber.
• If the dye class of the colorant set does not exist in the database, a dialog opens 

where you can select an equivalent dye class from your database.
 This is to avoid creating the same dye classes in different languages (e.g. Dis-

persion, Disperse, or Cationique and Basic etc).
If there is no dye class in the database that matches the dye class of the colorant 
set, click No Match . A new dye class is then created.

•  You can modify the dye class ID and name before you start the import.
• Click OK to start the import.
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Importing and Exporting Samples as QTX Files

Datacolor MONITOR can export/import samples to/from QTX files. A file always con-
tains a standard and its batch(es). It is not possible to select more than one standard. In 
this case, you must specify multiple export files.

Backing Up Using Datacolor MONITOR
The backup function saves the database to the selected target drive and folder.

Note
If you select only batches, the dialog box closes when you click „OK“. No samples are 
then exported.

Action Result

1 On the “Tools” menu, select 
Backup.

The “Backup” dialog box appears.

2 Specify target drive and path (or use 
the browse button), and click OK.

The contents of the database are 
saved.

Caution
Before the backup is made all databases are validated. This may take up to sev-
eral minutes depending on the size of the databases. If there is a problem with 
one of the databases, a message is displayed and the backup is not made. An old 
backup must be restored in this case.
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Backing Up Using Sybase Utilities
The backup utility is used to store running databases, database files, transaction logs, 
and write files.

You can access the backup utility ...

• using Sybase Central, or,
• using the system command line to call the dbbackup utility. This utility can be 

used for specifying batch or command files.
The backup utility copies the database file and the transaction log of a single database.

Backing Up Using Sybase Central
Backing Up A Running Database

Backing Up A Database File or A Running Database

Action Result

1 Start Sybase Central.

2 Connect the database.

3 Right-click the database and select 
Backup on the context-sensitive 
menu.

4 Follow the instructions of the wizard.

Action Result

1 Start Sybase Central.

2 Open the „Utilities“ folder in the left 
panel.

3 Double-click the Backup Database 
in the right panel.

4 Follow the instructions of the wizard.
3 - 16 Datacolor MONITOR Version 1.0 Datacolor



Backing Up Using Sybase Utilities 3 - Configuration and Administration
The dbbackup Command
Syntax
Dbbackup [switches] path

Switches

Switch Description

-c „keyword=value“ Database connection parameters. If the connection parameters are not 
specified, the parameters of the SQLCONNECT environment variable will be 
used (if they are set).
Parameters:
eng=engine
dbn=database name
uid=user ID The user must have DBA authority or REMOTE DBA 

authority.
pwd=password

-d Only stores the main database file.

-l file name Stores the transaction log file to a file with the specified name.

-n The switch is only active, if the switch -r is set.
Changes the name of the transaction log file to the following format:
yymmddnn.log
yy year
mm month
dd day
nn number in the range of 00 to 99.

-o file name Creates a file for the log output.

-q Quiet mode: Messages are not printed.

-r Rename and start a new transaction log.

-t Only stores the transaction log.

-w Only stores the write file.

-x Deletes and restarts the transaction log.

-xo Deletes and restarts the transaction log without backup.

-y Replaces files without confirmation.
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ASCII Output (Option)
The ASCII output option supports writing data to an ASCII file when you can print data. 
This option includes specifying, modifying and deleting ASCII forms.

Specifying ASCII Forms

Action Result

1 On submenu „ASCII Forms“ of the 
“Tools” menu, select New.

The “ASCII Output Definition” dialog 
box appears.

2 Select a template from the list, and 
click Next.

The „Data“ dialog box appears.
3 - 18 Datacolor MONITOR Version 1.0 Datacolor



ASCII Output (Option) 3 - Configuration and Administration
Folder without selected fields. Click the folder to open or to close it.

Folder with selected fields (signed by red dots). Click the folder to open or close it.

Non-selected field with opened properties. Double-click the icon to select the field. 
Click the icon to close the field properties.

Selected field with closed properties. Double-click the icon to deselect the field. 
Click the icon to open the field properties.

3 Select the fields to be written to the 
ASCII file.

The corresponding field properties are 
displayed.

The number of decimal digits can be 
altered for all fields of type „double“.

4 Click Next. The „Options“ dialog box appears.
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Field Delimiter If necessary, change the field delimiter.

Record Delimiter If necessary, change the record delimiter.

String Delimiter If necessary, change the string delimiter.

Field Description Line Check the box if a field description line is required.

Field Description Prefix If necessary, type a field description prefix.

File Name Type the path and the file name.
File Select „Append“ if the new records should be added to an 

existing file, or, 
select „Overwrite“ if the existing file should be overwritten.

5 Click Next. The „ASCII Form Name“ dialog box 
appears.

6 Type the name of the form, and click 
Finish.
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ASCII Output

Example: ASCII output of an affinity

Action Result

1 In the corresponding list window, 
select the object that should be 
printed to an ASCII file.

2 On the basic data menu, click 
ASCII.

The file is saved to the place specified 
in the ASCII form.

@"ID","Name","FiberGroup"
"55PES/45CV WASH","55PES/45CV washed 70° C","PES/VI"
@"Fiber","Part"
"Polyester",55.00
@"Fiber","Part"
"Viscose",45.00
@"QualityID","QualityName"
"55PES/45CV LICL","55PES/45CV Libero Classic"
*****
@"ID","Name","FiberGroup"
"CO3","C04200 (BASF) gebl.BW-RENFORC","CO"
@"Fiber","Part"
"Cotton",100.00
@"QualityID","QualityName"
"S4","C04200 (BASF) gebl.BW-RENFORC"
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Calibrating the Monitors Using Datacolor SPYDER2

This function is used to perform the monitor calibration for adjusting the color of the 
monitor. After calibrating the monitor, all color patches displayed on the screen are more 
similar to the color of the measured sample. A calibrated monitor enables you to judge 
and compare colors more correctly before dyeing.

Note
This function is enabled if the Datacolor SPYDER2 is connected to the USB port.

Action Result

1 In the „Tools“ menu, select 
Calibrate Monitor.

The assistant for monitor calibration 
appears.

2 Follow the advises on the screen.
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Specifying Print Forms Using the Pager
The pager is used to specify print forms. A set of forms is delivered by Datacolor. The 
user can modify these forms or specify new ones.

Starting the Pager

Specifying A New Print Form
Refer to Pager Window on page 6-35 for more information about the parameters.

1. On the Windows start menu or the desktop, click the Pager 
icon.
The “Pager” window appears.

Action Result

1 In the toolbar or on the “File” menu, 
select New.

The “Template Identification” dialog box 
appears.

2 Select “Application”, “Option” (object 
type), “Language”, and “Version”, 
and click OK.

An empty form appears containing all 
sections available for the selected 
option.

3 Click the section to be specified.

Inactivate an unused section:
On the Edit menu, select Hide Cur-
rent Section, or
select the requested section on the 
“Sections” menu.

Specifying a text field:
1. In the toolbar, select the text 

tool.
2. Draw and place the requested 

text field.
3. In the toolbar, select “Toggle 

Properties.”
4. Specify the text and change the 

other parameters if requested.

Specifying a database field:
1. In the toolbar, select “Toggle 

Properties.”
2. Select and place the requested 

database field. The parameters 
of the fields can be altered 
using the “Properties” box.

The check mark is removed and the 
section is not used in the current print 
form.

The “Properties” box appears.

The “Fields” list box opens displaying all 
available fields.
A text field for the description and a field 
for the data is displayed.
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4 Draw rectangles and ellipses:
1. In the toolbar, select the rectan-

gles or ellipses tool.
2. Draw and place the graph. The 

parameters of the graph can be 
altered using the “Properties” 
box.

Enter a bitmap graph:
1. In the toolbar, select the “Bit-

map” tool and click the selected 
section.

2. Search and select the graph
(supported are *.bmp, *.pcx, 
*.jpg graph), and click Open.

3. Place the graph. The parame-
ters of the graph can be altered 
using the “Properties” box.

Specifying date/time, page num-
ber or form (file) name:
1. In the toolbar, select the re-

quested tool and place the field.

Remove all field from the current 
section:
1. In the toolbar, select the 

requested tool and place the 
field.

Deleting a field:
1. Select the field and press Ctrl + 

Del.

The “Open” box appears.

5 In the toolbar or on the “File” menu, 
select Save (As).

The “Form Name” dialog box appears.

6 Specify a form name, and click OK. The new print form is created.
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Modifying A Print Form
Refer to Pager Window for more information about the parameters.

Deleting or Renaming A Print Form

Action Result

1 In the toolbar or on the “File” menu, 
select Open.

The “Template Identification” dialog box 
appears.

2 Select “Application”, “Option” (object 
type), “Language”, and “Version”, 
and click OK.

The selected form appears.

3 Alter the form as requested. Refer to 
Specifying A New Print Form on 
page 3-23.

4 In the toolbar or on the “File” menu, 
select Save, and click OK.

The print form is altered.

Action Result

1 In the toolbar or on the “File” menu, 
select Delete/Rename.

The “Form Maintenance” dialog box 
appears.

2 Select the requested form.

3 Rename: Click the form name, alter 
the name, and press ENTER.

Deleting: Select Delete, and con-
firm the deletion.

The name is altered.

The selected print form is deleted.
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Importing Print Forms

Exporting Print Forms

Action Result

1 On the “File” menu, select Import. The “Open” dialog box appears.

2 Search and select the form to be 
imported, and click Open.

The selected file is imported.

Action Result

1 On the “File” menu, select Export. The “Form Maintenance” dialog box 
appears.

2 Select the form to be exported and 
click Export.

The “Save as” dialog box appears.

3 Select the path, specify a file name, 
and click Save.

The selected form is exported.
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Customizing Graphs
The background color of all graphical displays and printouts is white, while text and 
curves are black with different line styles and the grid is activated by default.

You can have different settings for background and text color of the graphical displays 
and the printout. Modification of these settings are stored in the registry table of the 
database.

You can only modify the graphical settings in programs with graphical options such as 
the colorant set or the measurement program.

Setting Colors for Graphs

Action Result

1 On the context-sensitive menu, 
select Change Color  (for the dis-
play) or Change Printer Color  
(for color printers).

The „Choose Background Color“ dialog 
box  appears.

2 Select the background color and 
click OK .

The „Choose Text Color“ dialog box  
appears.

3 Select the text color and click OK .
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Setting Line Style and Color

Action Result

1 On the context-sensitive menu, 
select More .

The „Graphic Options“ dialog box  
appears.

2 In the „Curves“ tab , set style, 
color, and line width.

3 Click OK .
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Basics

Starting Datacolor MONITOR

Data Handling
Browse and Selecting
Using the object tree
All objects are displayed in a structured list on the left of the “Explorer” window.
Opening and closing structure levels:

Selection of objects:

Context-sensitive menu:
New Folder Adds a new subfolder to the selected folder. Type a meaning-

ful name.

Delete Deletes the selected folder (only if the folder is empty).

New Root Folder Adds a new root folder. Type a meaningful name.

Rename Is used to rename the selected folder.

Data Type in this Folder Opens the „Data in Folder“ dialog box used for searching 
data types and the corresponding data in the selected folder.
Refer to Data in Folder Dialog Box on page 6-7.

Find in Folder Opens the „Find <data type> in Folder“ dialog box used for 
searching data records with a determined name or part of the 
name. The <data type> of the opened list window is used.
Refer to Find in Folder Dialog Box on page 6-8.

Searching data types and the corresponding data in the selected folder
Refer to Data in Folder Dialog Box on page 6-7.

1 On the Windows start menu or the desktop, click the 
Datacolor MONITOR icon.
The "Batch Series" list window appears.

+ A + sign indicates that there are hidden subordinate folders and/or objects. 
Click the + sign to open the next structure level.

- Click the - sign to close all subordinate structure levels.

Action Result/Notes

1 Select the requested object folder 
using the left mouse button.

The object folder data is displayed in 
the corresponding view.
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Searching objects of a determined data type

Using the overview window
Clicking a button opens the corresponding list window. Refer to chapter Windows and 
Dialog Boxes on page 6-1, section Batch Series List Window on page 6-2.

Using the list windows
A mouse double-click in an object opens a window, dialog box, or property sheet, that is 
used to alter or delete the corresponding object data. Refer also to General table func-
tions on page 4-5.

Action Result/Notes

1 On the context sensitive menu, 
select Find in Folder.

The „Find <data type> in Folder“ dialog 
box is displayed. The data type of the 
opened list window is selected.

2 Type the name (or a part of the 
name) of the searched data records, 
select the search restrictions, and 
click Search.

Refer to Find in Folder Dialog Box on 
page 6-8.
The corresponding data is displayed.

3 Select one or more of the items in 
the „Search Result“ box and right-
click to display, print, or to make an 
ASCII output of the data.

Note
The number of data records to be displayed is limited to 1000. A message is displayed, 
if the limit is exceeded
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Selection aids for fields and table column headers 
The following selection aids are implemented for input fields with a link to another object 
(drop-down combo boxes or fields with a browse button):
Typed characters are used for search criteria. In front of the field, they are displayed in 
red and into disappointed brackets. The following wildcards are available:
% (percent) Replaces an undefined number of characters. % is set per 

default at the end of the search string.
_ (underscore) Replaces any single character. 

[         ] The characters (or a range of characters) between the 
square brackets are to be included in the data found.

Examples: [or] Displays only names that contain the characters o 
or r.

[b-h] Displays only names that contain the characters of 
the range b to h.

[^        ] The characters (or a range of characters) between the 
square brackets are not to be included in the data found.

If you scroll using search criteria, only the corresponding objects are displayed.
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General table functions
Selecting columns for sorting and filtering:

Changing the order:
Click the column title of the selected column for changing the order between ascending 
and descending.
A selection filter can be defined for each column:
1 If necessary, select the column title field.
2 Type the characters to be used as selection criteria. A binocular sign is displayed 

and the data is selected according to the criteria. 

• The wildcard % can be used.

• The selection criteria can be changed as long as the column is selected.

• Use Backspace to remove the character on the left of the cursor.

• Use Shift + Backspace to remove the entire selection criteria.

Examples:

The names of the table columns can be altered using the “User’s Browser Definition” 
function of the “Tools” menu. Refer to chapter Browser Customizing on page 3-6.

Tool tips
In many places tool tips are implemented: Setting the cursor to this place, a context-
sensitive information appears (refer to figure below).

Click the column title to be selected. The column is marked with sorting 
sign and arrow.
Data is sorted using two criterias: 
1st priority has the column you have clicked in;
2nd priority always has the object name (if it is selected in „User’s Brows-
er Definition“.).
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Opening context-sensitive menus
Context-sensitive menus are available in different windows, dialog boxes, and fields 
(Refer to the corresponding descriptions.). For opening, set the mouse cursor into the 
corresponding field or table column and click the right button.

Specifying, Modifying and Deleting Objects

Specify or modify an object, you can specify new objects of another linked object type 
using the corresponding tab or selection field.
Example: In the “Quality/Style Property Sheet”, you can specify a new affinity as fol-
lows:
• Use the “Affinity” tab.
• In the “Affinity” field of the “Quality/Style” tab, use the “Input Form” function of the 

context-sensitive menu.

Opening the input form

Note
The delete, move, copy, and rename functions are only available for users having the 
corresponding access rights.

Action Result/Notes

1 If available, select the corresponding 
tab,
or,
right-click the selection field where 
the new object should be entered.

A context-sensitive menu appears.

2 Select Input Form. The requested tab, box, or window 
appears.
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Specifying objects

Modifying and Deleting Objects

Action Result/Notes

1 Select a folder, if necessary.

2 Switch to the input mode. The input mode icon appears.

3 Specify the new object name or 
overwrite the existing name with the 
new one. 

4 Specify the other data. Fields marked with a red * are man-

datory.
Refer to the corresponding description 
in chapter Windows and Dialog Boxes 
on page 6-1 for more information about 
the parameters.

5 Click Insert. The new object is created.

Action Result/Notes

1 Select the object data to be modified 
or deleted.

Refer to Browse and Selecting on page 
4-2.

2 Modifying: In the requested fields, 
change the object data, and click 
Save.

The input mode icon appears.
The object is altered.

3 Deleting: Click Delete and confirm 
the deletion.

The object is deleted.

Note
An object cannot be deleted, if it is linked to other objects. If the system cannot delete 
an object, all valid links are listed in the “Delete Check” info box.
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Calibration and Measurement

Calibrating Your Spectrophotometer
Your spectrophotometer must always be calibrated after switching on. It is recommend-
ed to calibrate at least every eight hours. Different types of spectrophotometers have 
different settings. This section gives a general description of the calibration.

Note
• For further details about your spectrometer refer to the manual supplied with your 

system. 
• It is not possible to re-measure color types if they are linked to other tables.

Action Result/Notes

1 Check that your spectrophotometer 
is switched on.

Note
Leave the spectrophotometer to warm up for a few minutes. Datacolor recommends 
that for the greatest accuracy you should wait thirty minutes before calibrating.

2 If you select the Measure Directly 

button missing calibrations are 
requested automatically. 
For an intentional calibration, click 

the Measure button and in the 
opened “Measurement” dialog box, 
select the “Calibrate” tab.
After specifying the parameter val-
ues according to your spectropho-
tometer, click Calibrate.

Refer to Measurement Main Window 
on page 6-15.

3 Follow the advice on the screen.
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UV Calibration
Calibration Methods

Ganz/Griesser: This procedure uses the Ganz/Griesser calibration method. The light 
source is filtered to simulate the D65 Illuminant and the Ganz Griesser parameters are 
used to calculate the filter position. In addition, the target whiteness value is based on 
10¼ standard observer data.
CIE using D65/10: The light source is filtered to simulate the D65 illuminant. This is the 
procedure used to perform a CIE Whiteness evaluation.
ISO Brightness (C): The light source is filtered to simulate Illuminant C. This is the pro-
cedure used to perform an ISO Brightness evaluation.

Note
There are several methods that can be used to calibrate the adjustable UV filter posi-
tion. Please refer to the whiteness standard you are using to determine the method to 
be used.
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Example using the Ganz/Griesser method

The UV calibration is necessary to ensure a constant UV emission of the bulb.

Definition of the Ganz/Griesser whiteness parameters
This definition is necessary if a bulb or an other part of the optical illumination system 
has been replaced.

Note
The UV calibration is only available for instruments with the whiteness option.

Action Result/Notes

1 In the “Measurement Main Window”, 
select the UV Calibration tab.

2 Select specular Excl.

3 Set aperture LAV.

4 Click Whiteness Parameters. The „Ganz/Griesser Calibration” dialog 
box appears.
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Action Result/Notes

5 In the “Ganz/Griesser Calibration” 
dialog box, specify the “Nominal 
Whiteness”, and click Measure.

6 Repeat step 5 for all samples of your 
whiteness scale.

7 Click Calculate. The calibration results are displayed.
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“Instrument-specific Formula Parameters” dialog box:

Action Result/Notes

8 Re-calibrate until “dW/dS” is 
4000 ±10 (You must measure all 
samples again for each Re-calibra-
tion.).

The program optimizes the UV filter 
position for each re-calibration.

The value of this example is ok.

9 If the value is ok, click Accept. The “Instrument-specific Formula 
Parameters” dialog box appears.
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Checking the UV part of the bulb
The periodical check of the UV emission of the bulb is done using an „Illuminant Check-
er“ sample. The Ganz/Griesser whiteness is calculated and the UV filter is adjusted.

Action Result/Notes

1 In the “Measurement Main Window”, 
select the UV Calibration tab.

2 Select the „UV Calibration Method“.

3 Specify the whiteness of your „Illumi-
nant Checker“ sample in the “White-
ness of Test Tile” field, and click 
Auto-Calibrator.

The whiteness difference is calculated 
and the UV filter is adjusted automati-
cally (if the instrument supports it).

4 Repeat the “Auto Calibration” until 
the “Whiteness Difference“ is in the 
range of 1.5, then click Accept.
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Instrument Correlation
There is always some variation in performance between different instruments. This dif-
ference becomes a part of each color evaluation if the standard and batch measure-
ments are carried out using different instruments. While the inter-instrument agreement 
specification for Datacolor instruments is very tight when working with very small 
acceptability tolerances, small variations in instrument performance may have a signifi-
cant impact on all the color evaluations. Maestro offers the additional „correlation“ fea-
ture to reduce these performance differences further.
Correlation allows you to adjust the performance of an instrument in order to match it to 
another reference or „master“ instrument. This adjustment is carried out by the applica-
tion of „correlation“ factors calculated using the results of the spectral test. Using the dif-
ferences between the master measurement and the current measurement, the program 
calculates a set of factors that are applied to each measurement, and which reduce the 
color difference between the two measurements. By generating correlation factors for 
every instrument used in the supply chain, the measurements made by each unit can be 
adjusted to simulate the performance of a single master unit. The result of this is that 
the Pass/Fail decisions will reflect the differences in the samples rather than in the 
instruments used to measure them. These correlation factors are generated using Mae-
stro. The instrument correlation feature is enabled through the instrument driver mod-
ule, however, which is accessible using any Datacolor program, including Maestro.
Once the correlation factors have been generated, they can be applied to raw measure-
ment data to compensate changes in instrument performance. The adjusted measure-
ment data should then closely resemble the measurement data produced by the master 
unit.
By designating a single instrument as „master“, and generating correlation factors for 
every instrument used in the supply chain, you can minimize any color differences 
caused by differences in instrument performance. This allows you to share color data 
electronically, and you will have the confidence that the instruments' Pass/Fail decisions 
are accurate evaluations, regardless of the instrument(s) used for the measurement.

Configuring and Enabling the Maestro Correlation Feature

Notes
• Master Instrument: You must identify the master instrument. This is the instru-

ment used to generate the master measurements for the reference tile set. When 
you select „Install“ in the Maestro correlation feature, the information about the 
reference instrument will become available here.

• If the instrument correlation is enabled, all measurement data displayed and 
stored will be adjusted data.

• Instrument correlation can be enabled/disabled using any Datacolor program. 
The „Measurement Main Window“ is accessed using either an „Instrument“ menu 
or an instrument icon of the Datacolor program you are running.
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Action Result/Notes

1 In the “Measurement Main Window”, 
select the General Options tab.

2 In the left box, click „Correlation“. The „Correlation setup“ box appears on 
the right.

3 Select the master instrument. All information about the master instru-
ment selected appears in the corre-
sponding fields.

4 Click the button ON to enable the 
correlation feature, resp., the button 
OFF to disable it.

When enabled, each measurement 
made will be adjusted based on the cor-
relation data in the file identified at the 
bottom of the window.

5 Click Save options to save your 
settings.
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Green Tile Test
The green tile test checks the instrument after the calibration. If the test fails the instru-
ment must be calibrated again.

Configure the green tile test

Parameters
Perform diagnostic tile ... Values: ALWAYS The test is performed after each 

calibration.
OPTIONAL The test can be skipped.
NEVER The test is not performed.

Action Result/Notes

1 In the General Options Tab of the 
„Measurement Main Window“, select 
Green Tile Test.

2 Set the parameter values, and click 
Save Options.
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Test results:

The samples are named as follows:

Green tile test (Standard): __TEST SF3008 SCI UVINC

Green tile test (Batch): __TEST SF3008 SCI UVINC 010321 11:46

The name contains the type (SF300), the serial number (8), the measurement condition 
(SCI UVINC), and (only for samples) the date and the time of the measurement.
The instrument settings and the measurement conditions are displayed in the status bar 
of the „Measurement Main Window“.

Note
• Only CMC 1:2 is used for the test.
• If the test fails, the traffic light is red. If configured, the status of the instrument is 

set to „not calibrated“.
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Measurement

Single measurement using the “Measure Directly” button

Measurement using the “Measure” button

Single measurement

Note
The program stores the type (tab) of the last measurement. The tab used for the last 
measurement appears for each new one.

Action Result/Notes

1 Check that your spectrophotometer 
is switched on and calibrated.

Refer to Calibrating Your Spectropho-
tometer on page 4-8

2 Place the sample into the spectro-
photometer.

3 For a single measurement and if you 
do not need any parameter alter-
ations, click the Measure Directly 

button.

The measurement is executed.

4 Click Insert to save the measure-
ment.

Inserts a substrate delivery measure-
ment into the substrate deliveries, for 
example.

Action Result/Notes

1 Check that your spectrophotometer 
is switched on and calibrated.

Refer to Calibrating Your Spectropho-
tometer on page 4-8.

2 Click the Measure  button, or, 
on the context-sensitive menu, 
select Measure.

The “Measure” dialog box appears. 
Refer to Measurement Main Window on 
page 6-15.

3 Select the “Single” tab for a single 
measurement.
Select the “Multiple” tab for a multi-
ple measurement.
Select the “Until Tolerance” tab for 
an until tolerance measurement.

Refer to Single measurement on page 
4-18.
Refer to Multiple measurement on page 
4-19.
Refer to Until tolerance measurement 
on page 4-20.

Action Result/Notes

4 Place the sample to the spectropho-
tometer, and click the Measure but-
ton.

The results of the measurement are dis-
played in the subordinate tabs.

5 Click Close. The “Measurement” dialog box is 
closed.

6 Click Insert to save the measure-
ment.

Inserts a substrate delivery measure-
ment into the substrate deliveries, for 
example.
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Multiple measurement

Action Result/Notes

4 Place the sample to the spectropho-
tometer, and click the Measure but-
ton. 
For each additional measurement, 
move the sample and click Measure 
again.

The results are displayed in the graph 
and in the table. Average and deviation 
are calculated continually.
Refer to Multiple Tab on page 6-16 
(Measurement Dialog Box.)

5 In the table, cancel the unusable 
measurements using the mouse.
Click Accept Now to save the mea-
surement before the specified num-
ber is done.

Average and deviation are calculated 
continually.

6 If the specified number of measure-
ments is done, the „Measure“ button 
changes to „Accept“.
Click Accept to save the measure-
ment.

Inserts a substrate delivery measure-
ment into the substrate deliveries, for 
example.

7 Click Close. The “Measurement” dialog box is 
closed.
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Until tolerance measurement

Action Result/Notes

1 In the „General Options“ tab, select 
the Until Tolerance option.

The „Until Tolerance“ data box appears.

2 Select the formula, set the tolerance 
factor, and click Save Options.

3 Select the Until Tolerance tab.
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4 Place the sample on the spectropho-
tometer, and click the Measure but-
ton. 
For each additional measurement, 
move the sample and click Measure 
again.

The results are displayed in the graph 
and in the table. Average and 
deviation are calculated continually.
Refer to Multiple Tab on page 6-16 
(Measurement Dialog Box.)

5 In the table, cancel the unusable 
measurements using the mouse.
Click Accept Now to save the mea-
surement before the specified num-
ber is done.

Average and deviation are calculated 
continually.
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Specifying, Modifying or Deleting Tolerances

Specifying A New Tolerance

Action Result/Notes

1 Open the “Tolerance Block Program” 
dialog box.

Refer to Tolerance Block Program Dia-
log Box on page 6-22 for information 
about the parameters.

2 Specify the tolerance name

3 Select the requested tab and specify 
the tolerance values.
For Datacolor pass/fail formula refer 
to the following section.

Refer to Browse and Selecting on page 
4-2 and Specifying, Modifying and 
Deleting Objects on page 4-6.

4 Click Save. The new tolerance is created.
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Datacolor pass/fail formula

Action Result/Notes

1 Select the “Datacolor” tab.

2 Specify the tolerance name

3 • Click Datacolor Block Training 
for tolerance block calculation 
based on visually excepted stan-
dards and the related batches.

The “Datacolor Tolerance Block” dialog 
box appears.
Refer to Cie 94 Tab on page 6-29 for 
information about the parameters.

• For changing the formula, click 
Diff. Formula and select the for-
mula.

The „Select Difference Formula“ dialog 
box appears.

Select or measure the standard 
and the related batches.

In the table, the batches are listed. All 
batches with a CMC color difference <= 
1 are selected automatically.
Click the refused batches to select.

Select other colors (standards 
and batches) to specify a color-
independent tolerance block.

Select at least all colors you want to 
proof to get a useful tolerance block.

Click Apply. The „Datacolor Tolerance Block“ dialog 
box closes.

• Click Block Manual Input for a 
manual input of tolerance values.

The „Manual Input of Tolerance Values“ 
dialog box appears
Refer to Manual Input of Tolerance Val-
ues Dialog Box on page 6-32 for infor-
mation about the parameters.

Select or measure the standard 
and specify the tolerance values.

Click Apply The “Manual Input Tolerance Values” 
dialog box closes.

4 Click Save. The new tolerance is created.

Note
A Datacolor tolerance block can be modified by adding more standards and batches.
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Displaying Datacolor Tolerance Values

Modifying and Deleting Tolerance Values

Action Result/Notes

1 Select the requested “Datacolor” tol-
erance.

2 Click Tolerance Values. The “Tolerance Value Output” dialog 
box appears.
Refer to Tolerance Block Program Dia-
log Box on page 6-22.

3 Select or measure the requested 
batch.

The tolerance values are displayed.

Action Result/Notes

1 Open the “Tolerance Block Program” 
dialog box.

Refer to Tolerance Block Program Dia-
log Box on page 6-22 for information 
about the parameters.

2 Modifying: Select the tolerance, 
alter the data, and click Save.
Deleting: Select the tolerance, click 
Delete, and confirm the deletion.
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Datacolor MONITOR
Datacolor MONITOR is a color quality control software product that was designed to 
easily acquire color measurement data and pass/fail decisions for production quality 
control. The program is designed to compare side-center-side for fabrics. The major 
task was to design a software module that is easy to operate.

Specifying A Script
If you are starting the program for the 1st time, you must define a script to be able to 
measure a batch series. A script describes the measurements, the tolerances and the 
relations for the comparison.
1 On the Batch Series menu, select New Script.

2 Specify a name, a description (not mandatory), and click Next to continue.
Datacolor February 2005 4 - 25



Datacolor MONITOR User’s Guide 4 - Using Datacolor MONITOR
This dialog is very important. 
3 You have to decide ...

• wether the measurements should be compared to a reference sample;

• how many measurements should be taken in the horizontal direction (mea-
surements per line: maximum is 4), and;

• how many measurements per piece should be done in the vertical of a fabric. 

The measurements in horizontal direction are called „Tag 1", „Tag 2", „Tag 3", and 
„Tag 4". For each tag, you can give a name describing the position of the measur-
ing. This name is stored together with the spectrum and is used to identify the 
position.

If you check „Only one line“ the measurement program stops if the measurements 
defined in „Measurements per line“ are done. 

4 Select the Pass/Fail formula. 
5 Click Next to continue.

Note

• These names cannot be modified if a batch series exists using that script. Refer 
to Diagram: Measurement distribution on page 4-28.

• Up to four tags may be defined.
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6 Set the measurements you want to compare. You can set an individual tolerance 
factor for each relation.

There are three different types of relations:

• Relation with Standard (only if „Use reference“ is checked in the previous 
dialog);

• relation with previous batch (vertical);

• relation with batch on the same line (horizontal).

7 Click Finish to save the script.
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Diagram: Measurement distribution

This graph represents one piece of fabric, with three horizontal measurement positions 
(e.g. left - center - right) and three positions per piece (e.g. at the beginning, in the mid-
dle and at the end of the piece). In addition, the reference is included in the pass / fail 
task.

The circle repre-
sents a measure-
ment position.
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Specifying A Batch Series

Action Result/Notes

1 On the Batch Series menu, select 
Measure New Series.

The „Create Batch Series“ dialog box 
appears.

2 Type the name of the batch series, 
select the folder and the script.

3 If a reference is defined in the script, 
select or measure the reference 
sample.

If a reference is not defined, the section 
for the standard is disabled.

4 Click Ok to start the measurement. The measurement table and the „Mea-
sure Control“ dialog box appears.

Note
The name of the batch series is used as batch name together with an extension for the 
number of lines measured, e.g.,
M&S Lot 1173652_001
M&S Lot 1173652_002
M&S Lot 1173652_003
M&S Lot 1173652_004,

Each sample contains the spectra for the readings made at the positions left, center 
and right.
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5 Type the name or number for the 1st 
piece of fabric and click Measure to 
start the 1st measurement.

• The position you have to mea-
sure is displayed in the dialog 
box. 

• The program asks for the next 
reading as soon as the measure-
ment is done.

• If all measurements defined for a 
piece of fabric have been done, 
you can type the name of the 
next piece of fabric.

• If you forget it, the program asks 
for a new name.

• If your instrument is equipped 
with a feature button, you can 
trigger the measurement from the 
instrument.

• If the measurements of a line 
have been done, the color differ-
ences will be displayed.
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Adding A Graph Panel
You can add graph panels to the graphical display of all measurement positions and col-
or difference values.

Action Result/Notes

1 On the Batch Series menu, select 
Add Graph Panel.

Graph panels  are displayed for each 
measurement.

2 In the graph panel, click the right 
mouse button.

The „Difference Graph Settings“ dialog 
box appears. 
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3 For all graph panels, select the mea-
surement positions to be compared 
and the type of the difference value.

„iT“ is the normalized tolerance (dE/TF). 
This value is important if you work with 
different tolerance factors for the sam-
ple relations.

4 Save the screen using the Save 
Layout As function of the Batch 
Series menu.

Refer to Batch Series Window on page 
6-9 for an overview of all functions.
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Printing A Batch Series
The printout or print preview is based on print forms created with the „Print View 
Designer“. Two default forms are provided with the database „Printform.db“.
In the task „Options“ of the menu „Batch Series“, you can select wether all pass/fail 
decisions or only failed ones are to be printed.

Example of the default printouts
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Maintenance of the Spectrophotometer
Refer to the manual of your spectrophotometer.

Maintenance of the Database

Deleting Data
You can delete data objects in the corresponding windows and boxes.

Backup
Refer to Backing Up Using Sybase Utilities on page 3-16.

Error Handling
1 Note the error message and what you were doing before the error occurred.
2 Try to execute the advice of the error message. Example below: Specify a mini-

mum of one batch before clicking Save again.
3 Log out of Datacolor MONITOR and restart Windows.
4 Restart Datacolor MONITOR.

If the error occurs again, contact your Datacolor representative for further advice.

Error Messages
If an error message appears while you are using your system, you should follow the 
advice above.

Example of an error message:

Note
The delete, move, copy and rename functions are only available to users having the 
corresponding access rights.

Note
An object cannot be deleted, if it is linked to other objects. If the system cannot delete 
an object, all valid links are listed in the “Delete Check” info box.
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Explorer

Batch Series List Window

Title bar
The title bar contains the title of the program, the title of the current window and, if a list 
window is opened, the number of data records.

Menu bar
Refer to General Menu Functions on page 6-3 for the general functions or to the related 
window descriptions for window specific functions.

Status bar
Display of messages.

Menu Bar

Status Bar

Title bar
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General Menu Functions
File
Exit Closes the program.

Batch Series
Measure New Series Open the „Create Batch Series“ dialog box. Refer to Create 

Batch Series Dialog Box on page 6-10 and Specifying A 
Batch Series on page 4-29.

Build New Series Open the „Create Batch Series“ dialog box. Refer to Create 
Batch Series Dialog Box on page 6-10 and Specifying A 
Batch Series on page 4-29.

Open Series Opens the with data of the selected batch series. Refer to 
Batch Series Window on page 6-9 and 
Datacolor MONITOR on page 4-25.

New Script Opens the „Batch Series Script Name“ dialog box. Refer to 
Batch Series Script Name Dialog Box on page 6-11 and 
Specifying A Script on page 4-25.

Maintain Script Opens the „Batch Series Script Name“ dialog box. Refer to 
Batch Series Script Name Dialog Box on page 6-11 and 
Specifying A Script on page 4-25.

Illuminant Opens the „Select current Illuminants“ dialog box. Refer to 
Select Current Illuminants Dialog Box on page 6-14 and UV 
Calibration on page 4-9.

Options Opens the „Options“ dialog box to select the failed parts for 
printing. Refer to Printing A Batch Series on page 4-33.

Tools
User Manager Change Password: Refer to Changing the Password on page 

3-2.
User Administration: Refer to Specifying, Modifying and 
Deleting User’s Data on page 3-2.

Import Opens the “Import” dialog box for sample import. Refer to 
Import and Export on page 3-11.

Export Opens the “Export” dialog box for sample export. Refer to 
Exporting Data on page 3-11.

Backup Opens the “Backup” dialog box. Refer to Backing Up Using 
Sybase Utilities on page 3-16.

ASCII forms New: Opens the „ASCII Output Definition“ dialog box.
Change: Opens the „ASCII Output Definition“ dialog box. 
Delete: Opens the „Delete ASCII Form“ dialog box. 
Refer to ASCII Output (Option) on page 3-18.

Calibrate Monitor Function for calibrating monitors using Datacolor SPYDER2. 
Refer to Calibrating the Monitors Using Datacolor SPYDER2 
on page 3-22.

Tolerance Opens the “Tolerance Block Program” dialog box. Refer to 
Tolerance Block Program Dialog Box on page 6-22 and 
Specifying, Modifying or Deleting Tolerances on page 4-22.
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Instrument
Calibrate Instrument Opens the „Calibration Conditions“ dialog box. Refer to Cali-

brate Tab on page 6-18 and Calibration and Measurement on 
page 4-8.

Instrument Setup Opens the „Instrument Setup“ tab of the „Measurement Main 
Window“. Refer to Instruments Setup Tab on page 6-19 and 
Calibration and Measurement on page 4-8.

Measurement Setup Opens the „General Options“ tab of the „Measurement Main 
Window“. Refer to Instruments Setup Tab on page 6-19 and 
Calibration and Measurement on page 4-8.

Diagnostic Instrument Only if the green tile test is installed. Opens the „Prepare 
for Diagnostic“ dialog box. Refer to UV Calibration Tab on 
page 6-21 and Green Tile Test on page 4-16.

UV Calibration Only for instruments with whiteness option. Opens the 
„Measurement Main Window“. Refer to UV Calibration Tab 
on page 6-21 and UV Calibration on page 4-9.

Ganz/Griesser Calibration Only for instruments with whiteness option. Opens the 
„Measurement Main Window“. Refer to UV Calibration Tab 
on page 6-21 and UV Calibration on page 4-9.

Ganz/Griesser Parameters
Only for instruments with whiteness option. Opens the 
„Measurement Main Window“. Refer to UV Calibration on 
page 4-9.

Window
New Window Creates a copy of the currently selected window.

Cascade Arranges the overview and the opened windows as a cas-
cade.

Tile Arranges the overview in the upper and the opened window 
in the lower part of the explorer.

Help
Help Topics Opens the Acrobat Reader with the „Datacolor MONITOR 

Dye Lot User’s Guide“.

About Datacolor MONITOR
Opens the “About Datacolor MONITOR” information box with 
release, copyright and user information.

Note
Refer to the related window description for window specific menu functions.
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Folder Structure
All objects are displayed in a structured list at the 
left of the “Explorer” window.

Opening and closing structure levels
+ A + sign indicates that there are hidden subordi-

nate folders.

Click the + sign to open the next structure level.

- Click the - sign to close all subordinate structure 
levels.

Selection of object types
1. Select the requested object type using the left 

mouse button.
If “All Data” is selected, all object types can be 
displayed.

Context-sensitive menu

New Folder Adds a new subfolder to the selected folder. Type a meaning-
ful name.

Delete Deletes the selected folder (only if the folder is empty).

New Root Folder Adds a new root folder. Type a meaningful name.

Rename Is used to rename the selected folder.

Data Type in this Folder Opens the „Data in Folder“ dialog box used for searching 
data types and the corresponding data in the selected folder.
Refer to Data in Folder Dialog Box on page 6-7

Find in Folder Opens the „Find <data type> in Folder“ dialog box used for 
searching data with a determined name or part of the name. 
The <data type> of the opened list window is used.
Refer to Find in Folder Dialog Box on page 6-8
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Batch Series List
List of the specified batch series in the selected folder.
Context-sensitive menu:
Measure New Series Open the „Create Batch Series“ dialog box. Refer to Create 

Batch Series Dialog Box on page 6-10 and Specifying A 
Batch Series on page 4-29.

Build New Series Open the „Create Batch Series“ dialog box. Refer to Create 
Batch Series Dialog Box on page 6-10 and Specifying A 
Batch Series on page 4-29.

Open Series Opens the with data of the selected batch series. Refer to 
Batch Series Window on page 6-9 and 
Datacolor MONITOR on page 4-25.

New Script Opens the „Batch Series Script Name“ dialog box. Refer to 
Batch Series Script Name Dialog Box on page 6-11 and 
Specifying A Script on page 4-25.

Maintain Script Opens the „Batch Series Script Name“ dialog box. Refer to 
Batch Series Script Name Dialog Box on page 6-11 and 
Specifying A Script on page 4-25.

Illuminant Opens the „Select current Illuminants“ dialog box. Refer to 
Select Current Illuminants Dialog Box on page 6-14 and UV 
Calibration on page 4-9.

Options Opens the „Options“ dialog box to select the failed parts for 
printing. Refer to Printing A Batch Series on page 4-33.

User’s Browser Definition Opens the “Browse Columns for Explorer” dialog box. Refer 
to Browser Customizing on page 3-6.

Rename Is used to rename the selected object.

Delete Deletes the selected object after confirmation.

Move to Moves a selected object to another folder.

Filter Refer to Browse Filters on page 3-8.

Reset Filter Resets the selected filter.

Note
The delete and rename functions are only available to users with the corresponding 
access rights.
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Data in Folder Dialog Box
Used to search for data types and the corresponding data records stored in the folder 
selected in the folder structure.

Data type box: Shows all data types that the folder selected in the folder 
structure contains.

Data box Shows all data records of selected data type.

Context-sensitive menu of the Data box:
User’s Browser Definition Opens the “Browse Columns for Explorer” dialog box. Refer 

to Browser Customizing on page 3-6.

Rename Is used to rename the selected object.

Delete Deletes the selected object after confirmation.

Move to Moves a selected object to another folder.

Filter Refer to Browse Filters on page 3-8.

Reset Filter Resets the selected filter.

Note
The delete and rename functions are only available to users with the corresponding 
access rights.
Datacolor February 2005 6 - 7



Datacolor MONITOR User’s Guide 6 - Windows and Dialog Boxes
Find in Folder Dialog Box
Used for searching data records with a determined name or part of the name. The data 
type of the opened list window is used. Refer to Searching objects of a determined data 
type on page 4-3.

Search criteria:
You can type a complete name or a part of it. If you are typing a part it is necessary to 
check one or both of the boxes for leading or trailing text.

Additionally, you can select the time range of the last modification.
Buttons:
Search Starts the search.

Stop Stops the current search.

Clear removes all data from the input and list boxes.

Context-sensitive menu in the „Search Result“ table:
Display Displays a print preview of the selected object.

Print Prints data of the selected object.

ASCII Output Saves data of the selected object into a ASCII output.

Note
Wildcards cannot be used.
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Batch Series Window
Refer to:
• Adding A Graph Panel on page 4-31
• Printing A Batch Series on page 4-33

Navigation
Left and right cursor keys Navigates from one measurement line (orange vertical solid 

line) to the next or previous. Corresponding to their position, 
the numeric values are displayed with yellow background 
color in the table above. The pieces of fabric are separated in 
the graph panel by a dotted black vertical line. 

Results shown in the table
• One section with the average of all color differences, indicated by µ.

• One section with the standard deviation of all color difference, indicated by σ.
• The next section contains the result for all measurement on one line. This section 

is separated by the name of the piece of fabric.

Symbols describing the relation of the sample pairs used for color difference calculation:
Indicates color difference to a previous measurement, e.g., left to left, center to 
center or right to right.
Indicates color differences to a neighbor sample, e.g., left to center, center to 
right and right to left.
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Indicates color differences to the reference, e.g., left to reference, center to 
reference or right to reference.

You will have nine color difference decisions if you have checked all possible relations.

Create Batch Series Dialog Box
Refer to Specifying A Batch Series on page 4-29.

Name Name of the batch series.

Folder Selection of the folder.

Script Selection of the script.

Standard Selection of the Standard.

Batch Name Name of the Batch.

Batches Selection of the batches.

Description Field for a description of the batch series.
6 - 10 Datacolor MONITOR Version 1.0 Datacolor



Batch Series Script Name Dialog Box 6 - Windows and Dialog Boxes
Batch Series Script Name Dialog Box
Refer to Specifying A Script on page 4-25.
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Batch Series Type Dialog Box
Refer to Specifying A Script on page 4-25.
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Batch Series Relation Dialog Box
Refer to Specifying A Script on page 4-25.
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Select Current Illuminants Dialog Box
Refer to UV Calibration on page 4-9.
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Measurement Main Window
The “Measurement” dialog box is used for selection and setting up the instrument, cali-
bration, and measurement. Refer to Calibration and Measurement on page 4-8.

Single Tab (Example)

Refer to the manual of your spectrophotometer for instrument specific information.

„Color“ tab Shows the color of the measured sample.

„Reflectance“ tab Shows the reflectance values of the measured sample.

„Coordinates“ tab Shows the color coordinates (e.g., yxz Lab) of the measured 
sample.

„Conditions“ tab Shows the measurement conditions.
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Multiple Tab

Parameters
Used for a measurement series.

The graph and the fields show the result of the measurement. Average and deviation 
are calculated according to the selected measurements. 
In the table, the measurements can be selected or canceled using the mouse.

Measurements can also be canceled using the measurement selection and the DEL 
buttons at the top of the graph.

Accept now Selects all measurements.

Measure Executes the measurement.

Close Closes the “Measurement” dialog box and saves the cur-
rently calculated values.
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Until Tolerance Tab

Parameters
Used for multiple measurement until the color differences do no longer exceed the toler-
ance values.

The graph and the fields show the result of the measurement. Averages and deviation 
are calculated according to the selected measurements. 
Measurements can be selected or canceled in the table using the mouse.

Measurements can also be canceled using the measurement selection and the DEL 
buttons at the top of the graph.

Accept now Selects all measurements.

Measure Executes the measurement.

Close Closes the “Measurement” dialog box and saves the cur-
rently calculated values.
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Calibrate Tab
Opens the “Calibration Conditions” dialog box.

Refer to the manual of your spectrophotometer.
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Instruments Setup Tab

Parameters

Refer to the manual of your spectrophotometer.

Caution
An alteration of these parameters can interrupt the communication between the 
PC and the spectrophotometer.
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General Options Tab

Parameters
Definition of general parameters for single measurement, multiple measurement, until 
tolerance, calibration, and green tile test (Refer to Green Tile Test on page 4-16.).
Until tolerance Select the formula and specify the tolerance to be accepted.

Correlation Refer to Configuring and Enabling the Maestro Correlation 
Feature on page 4-14.
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UV Calibration Tab
Calibration Methods

Ganz/Griesser: This procedure uses the Ganz/Griesser calibration method. The light 
source is filtered to simulate the D65 Illuminant and the Ganz Griesser parameters are 
used to calculate the filter position. In addition, the target whiteness value is based on 
10% standard observer data.
CIE using D65/10: The light source is filtered to simulate the D65 illuminant. This is the 
procedure used to perform a CIE Whiteness evaluation.
ISO Brightness (C): The light source is filtered to simulate Illuminant C. This is the pro-
cedure used to perform an ISO Brightness evaluation.

Example Using the Ganz/Griesser Method

Refer to UV Calibration on page 4-9.

Note
There are several methods that can be used to calibrate the adjustable UV filter posi-
tion. Please refer to the whiteness standard you are using to determine the method to 
be used.
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Tolerance Block Program Dialog Box

General parameters
Name Unique name of the tolerance.

Modification Date of last tolerance.

User ID Identification of creating or modifying user.

Description Text field.

Buttons
Delete Deletes the selected tolerance.

Default Sets the default values in the selected tab.

Save Saves the current tolerance.

Close Closes the dialog box.

Refer the following pages for information about the tabs.
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CieLab Tab

Parameters
Table Input values for minimum and maximum tolerances.

Symmetric Tolerances Minimum and maximum values are symmetric.

Refer to Specifying, Modifying or Deleting Tolerances on page 4-22.
Datacolor February 2005 6 - 23



Datacolor MONITOR User’s Guide 6 - Windows and Dialog Boxes
CMC Tab

Parameters
Table Input values for minimum and maximum tolerances.

Refer to Specifying, Modifying or Deleting Tolerances on page 4-22.
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Datacolor Tab

Parameters
Datacolor Block Training Opens the “Datacolor Tolerance Block” dialog box.

Block Manual Input Opens the “Manual Input of Tolerance Values” dialog box.

Tolerance Values Opens the “Tolerance Values Output” dialog box used for 
information about tolerance values.

Refer to Specifying, Modifying or Deleting Tolerances on page 4-22.
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FMC2 Tab

Parameters
Table Input for tolerance value.

Refer to Specifying, Modifying or Deleting Tolerances on page 4-22.
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JPC79 Tab

Parameters
Table Input for tolerance value.

Refer to Specifying, Modifying or Deleting Tolerances on page 4-22.
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MS89 Tab

Parameters
Table Input of dE values. The other tolerance values are calculated.

Refer to Specifying, Modifying or Deleting Tolerances on page 4-22.

Note
The user can only modify the dE values. DH, DC and DL are calculated automatically. 
These values are displayed after saving the tolerance, and closing and opening the dia-
log box.
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Tolerance Block Program Dialog Box 6 - Windows and Dialog Boxes
Cie 94 Tab

Parameters
Table Input for tolerance values.

Refer to Specifying, Modifying or Deleting Tolerances on page 4-22.
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DIN99 Tab

Parameters
Table Input for tolerance values.

Refer to Specifying, Modifying or Deleting Tolerances on page 4-22.
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Datacolor Tolerance Block Dialog Box 6 - Windows and Dialog Boxes
Datacolor Tolerance Block Dialog Box

Standard Selection or measurement of the standard.

Batch Selection or measurement of the batch.

Diff. Formula (button) Opens the „Select Difference Formula“ dialog box for the 
selection of the formula.
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Manual Input of Tolerance Values Dialog Box

Import Dialog Box

Parameters
Import File Name Path and name of the file to be imported. Use the „Browse“ 

button for searching and selecting.

Browse (button) Displays the Windows standard „Open“ dialog box.
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Export Dialog Box 6 - Windows and Dialog Boxes
Export Dialog Box

Parameters
Radio buttons Selection of the sample format.

Selected Samples Selection of the color samples to be exported.

File Name Path and name of the export file.

Browse (button) Displays the Windows standard „Save as“ dialog box.
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Form Maintenance Dialog Box

Parameters
Form name Name of the print form.

Application Application.

Section Sub-program.

English Language of the print form.

Version Version of the print form.

Buttons
Export Exports the print form file to the selected location.
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Pager Window 6 - Windows and Dialog Boxes
Pager Window

Page View Designer specific Menu Functions
„File“ menu
Import Opens the “Open” dialog box used to import an exported 

print form.

Export Opens the “Form Maintenance” dialog box used to select and 
export print forms.

Delete/Rename Opens the “Form Maintenance” dialog box used for renaming 
and deleting print forms.

Page Setup Opens the “Page Setup” dialog box used for specifying the 
left and the right margin.

„Edit“ menu
Remove all fields from current section

Removes the fields from the selected section.

Hide current section Hides the selected section.

„Sections“ menu
List of the sections that are available for the current print form. Checked sections are 
currently used for the form.

„View“ menu
Toolbar Switches the toolbar on (check mark) and off.

Status Bar Switches the status bar on (check mark) and off.
Datacolor February 2005 6 - 35



Datacolor MONITOR User’s Guide 6 - Windows and Dialog Boxes
Fields Opens the “Fields” information box with the database fields 
used for the selected section.

Properties Opens the “Properties” of the selected field.

Look Opens the “Look” dialog box used for window settings.

„Layout“ menu
Help functions for a correct alignments of fields.

Page View Designer specific Toolbar Functions

1 About Page View Designer version info.
2 Grid, Zoom, Ruler Opens the “Look” dialog box used for window settings.
3 Toggle Fields Opens the “Fields” information box with the database fields 

used for the selected section.
4 Toggle Properties Opens the “Properties” of the selected field.
5 Left Alignment Active if more than one field is selected.
6 Top Alignment Active if more than one field is selected.
7 Right Alignment Active if more than one field is selected.
8 Same Horizontal Size

Active if more than one field is selected.
9 Same Vertical Size Active if more than one field is selected.
10 Text Used to specify a text field.
11 Rectangle Used to draw rectangles.
12 Ellipse Used to draw ellipses.
13 Bitmap Used to enter a picture, e.g., a logo. Supported formats: 

*.bmp, *.pcx, *.jpg.
14 Date/Time Used to enter a field with date and time.
15 Page Number Used to enter a page count field.
16 Form Name Used to enter a field for the form name.
17 Login User Used to insert the Name of the logged in user.
18 Zoom Selection of predefined zoom values.

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 1817
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